
一、单项选择

 1、AUTOCAD的坐标体系，包括世界坐标和（   D  ）坐标系。

A、绝对坐标    B、平面坐标     C、相对坐标     D、用户坐标

2、当进入了AUTOCAD环境中（即AUTOCAD的图形编辑器）时，缺省时所建立的

坐标系统为（   B    ）

A、用户坐标系    B、世界坐标系   C、相对坐标系    D、绝对坐标系

3、如需对所选图形作出规则的复制，该使用（  B   ）

A、执行COPY（复制）命令后，当出现“选择对象”时，再介入F

B、使用阵列命令    C、XCOPY    D、用“宏”命令

4、使用下面的哪个操作可以完成对所选图形的移动（  A   ）

A、MOVE   B、ROTAE    C、COPY     D、MOCORO

5、 用 LINE命令画出一个矩形，该矩形中有___B___图元实体。

　　A．1个    B．4个    C．不一定    D．5个

6、 用 STRETCH命令中的窗口方式完全将物体选中，则该操作与采用__B___命

令相同。

　　A．PAN    B．MOVE    C．SCALE    D．COPY

7、在执行FILLET命令时，先应设置__A____。

　　A．圆弧半径R   B．距离D   C．角度值   D．内部块Block

8、剪切物体需用___A___命令。

　　A．Trim    B．Extend    C．Stretch    D．Chamfer

9、当使用LINE命令封闭多边形时，最快的方法是__A____。

　　A．输入C回车   B．输入B回车   C．输入PLOT回车   D．输入DRAW回

车

10、 AutoCAD中的图层数最多可设置为__B____。

　　A．10层   B．没有限制   C．5层   D．256层

11、 CP是哪个命令的热键名__B____。

　　A．CIRLCE    B．COPY    C．CHAMFER    D．SPLINEDIT

12． ARC子命令中的（S，E，A）指的是哪种画圆弧方式__D____。

　　A．起点、圆心、终点    B．起点、终点、半径 

　　C．起点、圆心、圆心角落    D．起点、终点、圆心角

13、 CIRCLE命令中的TTR选项是指用__D_____方式画圆弧。

A．端点、端点、直径    B．端点、端点、半径

C．切点、切点、直径    D．切点、切点、半径

14、 在执行SOLID命令后，希望所画的图元内部填充，必须设置_A_____。

A．FILL为 ON    B．FILL为 OFF    C．LTSCALE    D．COLOR

15、 OFFSET命令前，必须先设置__C_____。

A．比例   B．圆   C．距离   D．角度

16、应用倒角命令“chamfer”进行倒角操作时：（c）

A、不能对多段线对象进行倒角                           

B、可以对样条曲线对象进行倒角 

C、不能对文字对象进行倒角  

D、不能对三维实体对象进行倒角

17、不是环形阵列定义阵列对象数目和分布方法的是：(C)

A、项目总数和填充角度  



B、项目总数和项目间的角度 

C、项目总数和基点位置 

D、填充角度和项目间的角度

18、移动圆对象，使其圆心移动到直线中点，需要应用：(D)

A、正交   B、捕捉   C、栅格    D、对象捕捉

19、用旋转命令“rotate”旋转对象时：(B)

A、必须指定旋转角度       B、必须指定旋转基点 

C、必须使用参考方式       D、可以在三维空间缩放对象

20、用缩放命令“scale”缩放对象是： (D)

A、必须指定缩放倍数       B、可以不指定缩放基点 

C、必须使用参考方式       D、可以在三维空间缩放对象

21、拉伸命令“stretch”拉伸对象时，不能：(A)

A、把圆拉伸为椭圆         B、把正方形拉伸成长方形 

C、移动对象特殊点         D、整体移动对象

22、拉长命令“lengrhen”修改开放曲线的长度时有很多选项，除了(B)：

A、增量     B、封闭     C、百分数     D、动态

23、不能应用修剪命令“trim”进行修剪的对象是(D)

A、圆弧     B、圆     C、直线     D、文字

24、AutoCAD中 CAD标准文件后缀名为(A)：

  A、dwg      B、dxf      C、dwt     D、dws

25、应用圆角命令“offset”对一条多段进行圆角操作是 (B)

A、可以一次指定不同圆角半径 

B、如果一条弧线段隔开两条相交的直线段，将删除该段而替代指定半径的圆角 

C、必须分别指定每个相交处

D、圆角半径可以任意指定
26、多次复制“copy”对象的选项为：（A）

A、m     B、d     C、p      D、c

27、在AutoCAD中给一个对象指定颜色特性可以使用以下多种调色板，除了

(A)：

A、灰度颜色     B、索引颜色    C、真彩色    D、配色系统

28、在AutoCAD中给一个对象指定颜色的方法很多，除了(D)：

A、直接指定颜色特性      B、随层“ByLayer” 

C、随块“ByBlock”       D、随机颜色

29、在AutoCAD中可以指定和添加各种类型文件的搜索路径，除了以下哪种文

件：(B)

  A、自动保存文件      B、AutoCAD主应用程序文件 

  C、菜单文件          D、样板图形文件

30、在AutoCAD中保存文件的安全选项是(B)：

A、自动锁定文件      B、口令和数字签名 

C、用户和密码        D、数字化签名

 31．在CAD中在用Line命令绘制封闭图形时，最后一直线可敲(A) 字母后回

车而自动封闭

 A．C   B．G   C．D       D．0



  32．在CAD中单位设置的快捷键是（  B  ）

 A．UM     B．UN      C．CTRL+U         D．ALT+U

  33．CAD软件中我们一般都用（C）单位来做图以达到最佳的效果 

A．米  B．厘米      C．毫米         D．分米

  34．在CAD中文本窗口切换的快捷键是（ B ）

 A．F1         B．F2         C．F3       D．F4

  35．在CAD中圆弧快捷键是（ B）

 A．tr       B．a           C．rec         D．pl

  36．在CAD中绘制圆的直径按（ D ）键

 A．b         B．w      C．p       D．D

37．在CAD中定数等分的快捷键是（  D   ）

 A．MI         B．LEN          C．F11          D．DIV

  38．在CAD中点的快捷键是（ C  ）

 A．W           B．O         C．PO            D．TR

  39．AutoCAD中绘制弧形的快捷键（C  ）。

 A．D           B．I            C．A           D．K

  40．AutoCAD中用多段线绘制弧形时D表示弧形的（ C ）

 A．大小       B．位置         C．方向          D．坐标

41．在CAD中图形界限的命令是( A   )

 A．alt+o+a         B．ctrl+0        C．alt+1         D．alt+2

  42．在CAD中查看距离命令是( C   ) 

 A．BI      B．CI           C．DI         D．F3

  43．在AutoCAD中复制其它文件中块的命令快捷键是（ B ）

 A．CTRL+ALT+C      B．CTRL+C   C．CTRL+SHIFT+C     D．CTRL+A

 44．在AutoCAD中写块(存储块)命令的快捷键是（  A ）

 A．W    B．I     C．L     D．CTRL+W

  45．在AutoCAD中粘贴其它文件的块的命令快捷键是(  D )

 A．V     B．CTRL+ATL+V    C．CTRL+SHIFT+V      D．CTRL+V

 46．在CAD中文字工具中输入下划线的命令是(  B   )

 A．%%1      B．%%U     C．%%3      D．contentamp;2

  47．在CAD中文字工具中输入直径符号的命令是( D   )

 A．%%1     B．%%U     C．%%3     D．%%C

  48．AutoCAD中轴线的颜色必须是( D   )

 A．绿色     B．黄色    C．蓝色    D．红色

 49．在CAD中外墙的宽度应该限制在(   B  )mm之间(.6分)

 A．0.05-0.09     B．0.6-0.9    C．1.6-0.9    D．0.03-0.06

  50．在CAD中线性管理器在（ D ）菜单下

 A．编辑    B．视图    C．工具     D．格式

  51．在CAD中以下有关图层锁定的描述，错误的是(B  )

  A．在锁定图层上的对象仍然可见

 B．在锁定图层上的对象不能打印

 C．在锁定图层上的对象不能被编辑

 D．锁定图层可以防止对图形的意外修改

  52．在CAD中当一对象从图形中被删除时，使用下述哪一个命令恢复该对象A



 A．ctrl+z     B．cancel     C．resto     D．replace

  53．在CAD中创建一个圆与已知圆同心，可以使用哪个修改命令C

 A．阵列    B．复制     C．偏移     D．镜相

  54．AutoCAD的英文全称是B___

 A．AutomAtic Computer Aided Design    B．Autodesk Computer Aided 

Design

 C．CAD2000        D．CAD2002

  55．在CAD中画完一幅图后，在保存该图形文件时用_D__作为扩展名。

 A．cfg     B．dwt     C．bmp     D．dwg

  56．在CAD中要始终保持物体的颜色与图层的颜色一致，物体的颜色应设置

为_A__

 A．按图层    B．图层锁定    C．按颜色     D．按红色

 57．在CAD中用LINE命令画出一个矩形，该矩形中有_B__图元实体

 A．1个  B．4个  C．不一定    D．5个

  58．在CAD中以下哪个设备属于图形输出设备(B)

 A．扫描仪      B．打印机     C．自动绘图仪    D．数码相机

  59．在CAD中图形编辑窗口与文本窗口的快速切换用_D__功能键

 A．F6   B．F7    C．F8     D．F2

  60．在CAD中用__C_命令可以设置图形界限

 A．SCALE    B．EXTEND    C．alt+o+a     D．LAYER

  61．在CAD中取消命令执行的键是(C)

 A．按回车键     B．按空格键     C．按 ESC键      D．按 F1键

  62．在CAD中以下哪个操作用于移动视图(B)

 A．ZOOM/W    B．PAN     C．ZOOM      D．ZOOM/A

  63．在CAD中 SAVE命令可以_A__

 A．保存图形         B．会退出Autocad

 C．定期地将信息保存在磁盘上          D．以上都是

  64．在CAD中如果可见的栅格间距设置得太小， AutoCAD将出现如下提示(B)

 A．不接受命令         B．“栅格太密无法显示”信息

 C．产生错误显示      D．自动调整栅格尺寸使其显示出来

  65．在CAD中如果执行了缩放命令的“全部”选项后，图形在屏幕上变成很

小的一个部分，则可能出现的问题是(D)

 A．溢出计算机内存          B．将图形对象放置在错误的位置上

 C．栅格和捕捉设置错误       D．图形界限比当前图形对象范围大

 66．在CAD中图层上对象不可以被编辑或删除，但在屏幕上还是可见的，而且

可以被捕捉到则该图层被_B__

 A．冻结     B．锁定    C．打开      D．未设置

67．在CAD中为了保证整个图形边界在屏幕上可见，应使用哪一个缩放选项(A)

 A．全部      B．上一个    C．范围       D．图形界限

68．在CAD中在圆上捕捉圆心时,靶框应该是压在(D)

 A．圆外      B．圆内      C．圆心     D．圆周上

69．在CAD中下列不可以用分解命令分解的图形(A)

 A．圆形     B．填充的图案    C．多线     D．块

70．在CAD中要创建矩形阵列，必须指定_C__



 A．行数.项目的数目以及单元大小      B．项目的数目和项目间的距离

 C．行数.列数以及单元大小      D．以上都不是

71．在CAD中以下有关多边形的说法错误的是__B_

 A．多边形是由最少 3条至多1024条长度相等的边组成的封闭多段线

 B．绘制多边形的默认方式是外切多边形

 C．内接多边形绘制是指定多边形的中心以及从中心点到每个顶角点的距离，

整个多边形位于一个虚构的圆中

 D．外切多边形绘制是指定多边形一条边的起点和端点其边的中点在一个虚构

的圆中

72．在CAD中以下有关图层锁定的描述，错误的是(B)

 A．在锁定图层上的对象仍然可见

 B．在锁定图层上的对象不能打印

 C．在锁定图层上的对象不能被编辑

 D．锁定图层可以防止对图形的意外修改

73．在CAD中一组同心圆可由一个已画好的圆用___D_____命令来实现

 A．拉伸STRETCH     B．移动MOVE       C．拉伸EXTEND    D．偏移

OFFSET

74．在CAD中用POLYGON命令画成的一个正六边形，它包含___A______个图元

 A．1个    B．6个    C．不确定      D．2个

75．在CAD中使用POLYGON命令绘制正多边形，边数最大值是(D)

 A．300    B．50     C．100     D．1024

76．在CAD中移动圆对象，使其圆心移动到直线中点，需要应用_D__

 A．正交      B．捕捉      C．栅格       D．中心捕捉

77．在CAD中拉长命令修改开放曲线的长度时有很多选项，除了_B__

 A．封闭         B．百分数     C．动态       D．增量

78．在CAD中不能应用修剪命令“trim”进行修剪的对象是：(.D)

 A．圆弧     B．圆      C．直线      D．文字

49．在AutoCAD中给一个对象指定颜色特性可以使用以下多种调色板，除了：

(A)

 A．灰度颜色     B．索引颜色      C．真彩色       D．配色系统

80．AutoCAD软件不能用来进行：(A)

 A．文字处理     B．服装设计     C．电路设计     D．零件设计

  81．在CAD中在启动向导中，A u t o C A D使用的样板图形文件的扩展名是

什么(B)

 A．DWG     B．DWT     C．DWK     D．TEM

82．在CAD中把用户定义的块作为一个单独文件存储在磁盘上可用___命令(A)

 A．W       B．AVE (菜单为[File]=>[Save])      C．S

 D．BLOCK (菜单为[Draw]=>[Block]) INSERT (菜单为[Insert]=>[Block

83．在CAD中可以用 __A_____ 命令改变层的颜色属性

 A．颜色      B．图层       C．选择

84．在CAD中标注是C___颜色的

 A．红色      B．蓝色      C．白色      D．黄色

85．在CAD中命令spl是_A__

 A．样条曲线       B．直线      C．射线     D．构造线



86．在CAD中多文档的设计环境允许？(B)

 A．同时打开多个文档，但只能在一个文档上工作

 B．同时打开多个文档，在多个文档上同时工作

 C．只能打开一个文档，但可以在多个文档上同时工作

 D．不能在多文档之间复制、粘贴

87．在CAD中在AutoCAD 2006中，用于打开／关闭“动态输入”的功能健是?

(D)

 A．F9     B．F8     C．F11     D．F12

88．绘制矿山制图时，怎么在CAD中打开扫描仪扫描的图像？(A)

 A．插入菜单——光栅图像      B．视图菜单——光栅图像

 C．文件菜单——光栅图像       D．窗口菜单——光栅图像

二、多项选择

1．AUTO CAD软件，主要应用在（ABCD  ）

  A．造船     B．建筑     C．服装      D．机械设计

2．在CAD中草图设置中可以设置以下捕捉模式（ABCD）

 A．端点      B．切点    C．中点    D．圆心

3．在CAD中视图缩放具有以下哪几种缩放效果（ABC）

 A．放大     B．缩小     C．全部     D．整体

4．在CAD中栅格设置中可以设置（ AB  ）

 A．栅格X轴间距     B．栅格Y轴间距     C．捕捉X轴间距

 D．捕捉Y轴间距

5．在CAD中常见外墙体厚度有哪些(  ACD  ) 

  A．490     B．560     C．370      D．240

6．在CAD中下列关于定数等分错误的有( BCD   )

 A．定数等分可以设置无数个段

  B．定数等分只可以有十个以上个段

  C．定数等分只可以十个以下个段

  D．以上全不对

7．在CAD中以下对点样式说法错误的是(  BCD  )

 A．点样式可以设置点的大小     B．点样式不可以设置点的大小

  C．点样式可以设置点的方向     D．点样式不可以设置点样式

8．在CAD中以下对圆角说法错误的有( ACD  )

 A．圆角只可以画90度的弧形     B．圆角可以随意调整度数

  C．圆角不可以画45度的弧形     D．以上说法全都正确

9．AutoCAD中对锁定的图层可以进行以下哪些操作(AB)

  A．捕捉     B．绘制     C．编辑      D．删除

10．在CAD中下列不是修剪工具的快捷键是（  BCD   ）

 A．tr    B．po     C．m     D．rec

11．在CAD中下列不是延伸工具的快捷键是（ BCD    ）

 A．ex     B．di     C．ray     D．a

12．在CAD中用阵列命令“ar”阵列对象时有以下阵列类型：(BD)

  A．曲线阵列     B．矩形阵列    C．正多边形阵列    D．环形阵列



13．在CAD中用偏移命令“offset”偏移对象时： AC

  A．必须指定偏移距离     B．可以指定偏移通过特殊点

  C．可以偏移开口曲线和封闭线框   D．原对象的某些特征可能在偏移后消失

14．在CAD中用镜像命令“mirror”镜像对象时：(AC)

  A．必须创建镜像线      B．可以镜像文字,但镜像后文字不可读

  C．镜像后可选择是否删除源对象    D．用系统变量“mirrtext”控制文字

15．在CAD中以下哪些对象不能被删除：(AC)

  A．坐标系     B．文字对象  C．锁定图层上的对象

  D．不可打印图层上的对象

16．在CAD中用旋转命令“rotate”旋转对象时，基点的位置 (AC)

  A．根据需要任意选择     B．一般取在对象特殊点上

  C．可以取在对象中心     D．不能选在对象之外

17．在AutoCAD中，可以通过以下方法激活一个命令 (ABC)

  A．在命令行输入命令名     B．单击命令对应的工具栏图标

  C．从下拉菜单中选择命令     D．右击

18．在CAD中当图形实体被使用 Erase 命令删除后，即可以使用___来恢复

(AB)

  A．CTRL+Z    B．U    C．MI     D．Copy

 19．在CAD中把一个画好或编辑好的图形保存到磁盘上，可使用的方法有___ 

(ABCD)

  A．文件[File] 保存[Save]     B．文件[File] 另存为[Save as]

  C．鼠标左键点击工具条上保存按钮      D．输出(Export)

20．在AUTOCAD系统中，可用于保存当前编辑内容的命令是(ABCD)

  A．W       B．SAVEAS     C．QSAVE     D．SAVE

21．在CAD中计算机的主要组成是___(ABCDE)

  A．硬盘      B．中央处理器（CPU）     C．外存储器

  D．内存储器（简称内存）     E．输入/输出(I/O)接口

22．在CAD中制作矿山图时当比例尺为1:2000时下列哪些不是在CAD中正确的

网格宽度(  )(ABC)

  A．400     B．500      C．300     D．200

23．制作矿山图时当比例尺为1:5000时下列哪些不是标准的字高( BCD  )

 A．12.5    B．12    C．14     D．13.5

24．制作矿山图时当比例尺为1:5000时哪些线不属于绘制断层的线标准线宽( 

ABD  )

 A．1     B．2     C．1.5      D．2.5

25．下列哪些不是制作矿山图的专业软件(BCD)

  A．CAD      B．3D     C．FLASH     D．PS

26．制作矿山图时当比例尺为1:2000时下列哪些不是标准的字高( ABC  ) 

  A．12.5     B．12     C．10      D．5

27．线性标注不可以测量什么样的线( ACD  )

 A．弧线    B．直线     C．斜线      D．以上都不可以测量

28．进入标注管理器的快捷健下列中错误的有(  BCD  )

 A．D     B．C     C．A    D．B



29．下列哪些不是打断的快捷键(BCD)

  A．BR     B．EL    C．E     D．H

30．下列哪些不是删除的快捷键(ACD)

  A．BR     B．EL     C．E      D．H

31．下列哪些不是绘制椭圆形的快捷键( ABD)

 A．BR      B．EL      C．E     D．H

32．下列哪些不是填充的快捷键(ABC)

 A．BR    B．EL     C．E     D．H

33．下列哪些不是栅格的快捷键(ABD) 

A．BR     B．EL     C．F7     D．F6

34．在CAD中，新建页面的快捷键错误的是（  ABD   ）

 A．Ctrl+b     B．Ctrl+I     C．Ctrl +n     D．Alt +c

35．在CAD中，对新键纸张有几种方法说法错误的是（  BCD   ）

 A．3种      B．4种    C．8      D．7

三、判断题

1、在AutoCAD中无法使用透视方式观察三维模型。(×)

2、范围缩放可以显示图形范围并使所有对象最大显示。 (√)

3、缩放命令“zoom”和缩放命令“scale”都可以调整对象的大小，可以互换

使用。(×)

4、“多行文字”和“单行文字”都是创建文字对象，本质是一样的。(×)

5、可以通过输入一个点的坐标值或测量两个旋转角度定义观察方向。(√)

6、AutoCAD无法实现类似 Word的文字查找或者替换功能。(×)

7、在AutoCAD中查询距离仅报告两点之间的真实三维距离。(×)

8、 STRETCH命令只能将实体拉长。(×) 

9、OOPS能把上一次被 ERASE命令删除的实体恢复出来，且只能恢复一次。(√)

10、 用 AutoCAD绘制图形时，其绘图范围是有限的。(×)

11、COPY命令产生对象的拷贝，而保持原对象不变。（√）

12、用户坐标系统（UCS）有助于建立自己的坐标系统。（√）

13、 特殊点一定要在执行绘图命令和编辑命令等后才能捕捉。（√）

14、所有的图层都能被删除。（×）

15、MIRROR，OFFSET，ARRAY命令实际上都是广义的物体复制命令。（√）

16、 用 MLINE命令只能同时绘制两条线。（×）

17、 STRETCH命令只能将实体拉长。（×）

18、OOPS能把上一次被 ERASE命令删除的实体恢复出来，且只能恢复一次。

（√）

19、 用 AutoCAD绘制图形时，其绘图范围是有限的。（×）

20、STRETCH命令不能改变圆的形状。（√）

21．在AUTO CAD软件中取消操作应按 ESC键（√   ） 

22．AUTO CAD是一个计算机辅助设计软件（ √   ） 

23．AUTO CAD是一个矢量图软件，放大，缩小都不会变虚（ √   ）

24．AutoCAD中 TR表示修剪命令(√)

25．在AutoCAD中任何图形都是可以分解的(×)

26．在AutoCAD中标准橱柜的宽度是650(×)

27．在CAD中对象捕捉没有快捷键(×)



28．在CAD中画多段线是有限制的(×)

29．CAD中是否可以改变捕捉的角度(×)

30．在CAD中在一个视口中，可以有多种样式的点样式(×)

31．AutoCAD图层可以隐藏的(√)

32．AutoCAD中锁定的图层在任何情况下都可以进行编辑、删除(×)

33．在CAD中所有图层均可加锁，也可以关闭所有图层。(×)

34．在CAD中图元特性器中图层可以命名'0'(×)

35．在CAD中修剪工具只可以对一个对象实行一次修剪（(×)   ）

36．在CAD中一张图中只充许有一种强的厚度（　(×)　　

37．在CAD中对象追踪没有快捷键（　(×)　　

38．在CAD中移动圆对象，使其圆心移动到直线中点，需要应用对象捕捉(√)

39．在CAD中用尺寸标注命令所形成的尺寸文本,尺寸线和尺寸界线类似于块,

可以用EXPLODE命令来分解(√) 

40．在CAD中用插入命令把块图形文件插入到图形中之后,如果把块文件删除,

主图中所插入的块图形将会被删除(×)

41．在CAD中 PAN和 MOVE命令实质是一样的,都是移动图形(×)

42．在CAD中当正交命令为打开时,只能画水平和垂直线,不能画斜线(√)

43．在CAD中用DT命令写的多行文本,每行文本成为一图元可独立进行编辑

(√)

44．在CAD中没有封闭的图形也可以直接填充。(×)

45．在CAD中默认图层为0层，它是可以删除的。(×) 

46．在CAD中单独的一根线也可以通过修剪来删除(×)

47．在CAD中所有图层均可加锁，也可以关闭所有图层。(√)

48．在CAD中加锁后的图层，该层上物体无法编辑，但可以向该层画图形(√)

49．在CAD中在没有任何标注的情况下，也可以用基线和连续标注。(×)

50．在CAD中多线可以直接倒角或倒圆(×)

51．在CAD中图块做好后，在插入时，是不可以放大或旋转的。(×) 

52．在CAD中缩放命令“zoom”和缩放命令“scale”都可以调整对象的大小，

可以互换使用(×) 

53．在CAD中“多行文字”和“单行文字”都是创建文字对象(√)

54．在CAD中倒直角的命令是chA(√)

55．AutoCAD软件的设计特点是精确(√)

56．AutoCAD的层不可以改名的是０层(√)

57．在CAD中在一个视图中，一次最多可创建 3 个视口 (×) 

58．在CAD中为了绘制多个连接线段，必须多次调用L I N E命令(×) 

59．在CAD中从不同的起点绘制两条射线，必须调用R A Y命令两次(√)

60．在CAD中处于冻结状态的图层能设置为当前层(√)

61．在CAD中栅格用以辅助绘图，不但在屏幕上出现，也同样会出现在输出的

图纸上(×) 

62．在CAD中使用“修改标注样式”对话框的“直线和箭头”子对话框中的

“隐藏”选项，一次仅允许隐藏一条尺寸界线(×) 

63．在CAD中使用PAN命令，不会改变显示子图形的位置(√)

64．在CAD中在多线样式设置中,最多能设置2条线 (×) 

65．在CAD中多线不能使用修剪命令进行编辑(√)



66．在CAD中圆环命令用于绘制指定内外直径的圆环或填充圆(√)

67．在CAD中用块BLOCK命令定义的内部图块， 只能在定义它的图形文件内自

由调用(√)

68．在CAD中，块可以随意缩放(×)  

69．在CAD中，可以有断线(×) 

70．在CAD中，可将物体入置在墙外(×) 

71．使用扫描仪时，可以不用安装直接使用(×) 

72．在CAD中，全屏的快捷键是Ctrl+0(√)

73．在CAD中，文字样式不可以调整字的大小(×) 

74．在CAD中不可能设置任何线宽。(×) 

四、简答题

1、使用多段线（PLINE）命令绘制的折线和用直线（LINE）命令绘制的折线段

完全等效吗？两者有何区别？

答：不完全等效。区别在于用多段线（PLINE）命令绘制的折线段是一个图形对

象，而用直线（LINE）命令绘制的折线段则是由构成折线的多条直线组成的多

个图形对象。

2、比较 ERASE，OOPS命令与UNDO，REDO命令在功能上的区别。

答：ERASE命令是将当前图形中指定的已有图形对象删除；而 UNDO命令则是取

消上一步所执行的命令。OOPS命令是恢复由上一个 ERASE 命令删除的对象；

而 REDO命令则是恢复上一步用UNDO所取消的命令。

3、为何用点的等分时，没有出现点？

答：这是因为点的样式不对，默认的点样式就是一个点，与线重合在一起，当

然看不见。

4、在输入汉字时为何出现“？”，怎样解决？

答：没有相应的字体文件

5、当屏幕出现暂时无法移动时，怎么办？

答：重新设置绘图界限，或者将图重生成一下

6、为何在状态栏的“对象捕捉”选中的情况下，出现特殊点无法捕捉的现象？

答：这是因为诶有设置相应的捕捉方式

7、圆在放大时，出现多边形的情况怎样解决？写出操作的完整过程.

答：可以用RE命令就会显示出圆形了！还有就是用VIEWRES命令把变量设置大

点

8、在标注时的比例因子与整体比例如何控制？

答：比例因子支队设置它的标注其作用，整体比例对全部的标注起作用。

9、简述块得优点。

答：（1）提高绘图速度（2）修改方便（3）节省存储空间（4）加入属性信息

五、填空题

1．在CAD中 Computer Aided Design是的全写，意思为计算机辅助设计(CAD)

2．AutoCAD文件扩展名为，模板文件扩展名为(DWG,DWT)

3．在CAD中绘制水平线或垂直线时，可用命令设置(正交（Ｆ８）)

4．在CAD中多段线的快捷键为(ＰＬ)

5．CAD软件是哪个公司出产的(AUTODESK)

6．CAD软件是一个图软件(矢量)



7．在CAD中直线的命令的快捷键是(L)

8．在CAD中多段线的快捷键是(PL)

9．在CAD中圆角的快捷键是(F)

10．在CAD中正多边形的命令是(pol)

11．在CAD中镜相的命令是(mi)

12．在CAD中打开特性面板的快捷方式是(ctrl+1)

13．在AutoCAD中延伸的快捷键是，按 F键是(EX，框选)

14．AutoCAD中绘制矩形的快捷键(rec)

15．AutoCAD中同一张绘图纸上允许出现种点样式(一)

16．在AutoCAD中旋转命令的快捷键是(RO)

17．在AutoCAD中创建块命令的快捷键是(B)

18．在AutoCAD中分解命令的快捷键是(X)

19．在AutoCAD中插入块命令的快捷键是(I)

20．在CAD中设置捕捉在栏(状态)

21．在CAD中单行文字工具的命令是(DT)

22．在CAD中多行文字工具的命令是(T)

23．在CAD中文字样式的命令是(ST)

24．在CAD中图元特性管理器又叫(图层特性管理器)

25．在CAD中打开图元特性管理器的快捷键是(LA)

26．AutoCAD中可以创建个图层(无限)

27．在CAD中打开线性管理器的命令是(Alt+o+n)

28．在CAD中在对象捕捉中按键可以启动对象捕捉(F3)

29．在CAD中在对象捕捉中按键可以启动极轴追踪(F10)

30．在CAD中拉长的快捷键是(len)

31．AUTOCAD默认有个菜单(12)

32．AutoCAD允许一幅图包含 层(无限制)

33．在CAD中绘制圆通常有种方式(6)

34．在CAD中既可以绘制直线，又可以绘制曲线的命令是(多段线)

35．AutoCAD中的＂Ｃ＂的缩写是(Computer)

36．AutoCAD为（国家）的Autodesk公司的产品(美国)

37．Autocad是年首次推出，是目前使用最普遍的计算机辅助绘图的软件之一

(1982)

38．AutoCAD 中 F1键的功能是(帮助)

39．扫描图像时，常用分辨率是(300)

40．在CAD中，绘制椭圆的快捷键是(EL)

41．在CAD中，工具选项板在的快捷键是(F7)

42．在CAD中，填充的快捷键是(H)

43．在CAD中，直角又可以叫做(倒直角)

44．在CAD中，图元是的个体(单独)

45．在CAD中，打断的快捷键是(DR)

46．在CAD 中，从图形中删除对象可以按快捷键(E)

47．在CAD中，z空格A空格表示(缩放全部)

48．在CAD中，完成图后，要将它们(定义成块)

49．在CAD中，恢复命令的快捷键是(Ctrl+Y)



50．在CAD中，对象编组的快捷键是(G)

51、AutoCAD默认打开的工具栏有：标准，绘图，修改，对象特征，图层，样

式，工具栏。

52、有两个命令常用于绘制作图辅助线，它们是RAY，XLINE。

53、分解命令EXPLODE可分解的对象有块 ，多段线，尺寸，图案填充。

54、一个图案填充被分解后，其构成将变成：直线。

55、利用几何计算器进行计算使用的命令CAL


